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Template of the Yearbook of Music Psychology (JBDGM) for anonymized initial submissions of research reports 
This template is exclusively designed for initial submissions of research reports or short papers. For all other manuscript types (spots, close-ups, reviews, reports), we provide separate templates at the following link: https://jbdgm.psychopen.eu/index.php/JBDGM/einreichen 
Research reports are the primary section of JBDGM for original research and reviews. We only accept original work that has not been published elsewhere. The anonymized initial submission is subject to an anonymous peer-review process with multiple external expert reviewers. The review process is double-blind so that authors and reviewers are mutually anonymous to each other during this time. It is therefore important that initial submissions do not allow any direct conclusions about the identity of the authors:
No mention of your names on the front page; 
Anonymization of references to your own literature;
No acknowledgements, statements on funding or competing interests;
Remove references to your identity from the metadata of the Word document.
To disclose your identity to the editors and the editorial board members, please also provide the “JBDGM Cover Letter to the Editors”, which has to be submitted along with the research manuscript. For this cover letter, a separate template is also available at https://jbdgm.psychopen.eu/index.php/JBDGM/einreichen
Please note the following general guidelines:
The length of a research report may not exceed 60,000 characters incl. spaces when first submitted. This limit refers to the whole manuscript including front page, abstracts, keywords, references and, if applicable, appendices.
JBDGM follows the guidelines of the American Psychological Association (APA, 7th edition) for text formatting, but with some exceptions. Therefore, please pay close attention to the “Notes on Manuscript Formatting” at the end of this document.
The italic text passages highlighted in yellow in this template provide you with important information regarding manuscript formatting. These guidelines can and should be deleted later on, together with this introductory instruction page and the notes at the end of this document.
Please do not waste time optimizing the layout of your manuscript. This file is primarily used to transmit text content and structure to the publishing house. Since JBDGM texts appear online and in print in various formats, the final layout will be adapted to the relevant publication medium and format in the course of the publication process. 

Insert Running Head Here (no more than 50 characters)
Note: The running head only appears once on the first page of the manuscript and not, like in APA style, on every page in the header. Please type the running head (in upper- and lower-case letters as shown above) into the regular body of the document and not separately into the header. 
Insert Article Title Here
Insert German Title Here
Important: This document will be assessed in a double-blind review process. Therefore, please do not insert information revealing/regarding the authors!
Abstract
Insert an abstract (up to 250 words for research reports) here. 
Note: Please do not include any references or statistical measures (italics) in this section. A professional language editing of the entire manuscript is part of the authors’ responsibility. The quality of the English will be reviewed and, if found to be insufficient, the submission will be returned. This means a delay in the review process. 
German Abstract
Insert German abstract (up to 250 words for research reports) here. 
Keywords
Insert 5 to 10 keywords here.
Note: Please note that keywords are lowercase (except nouns) and separated by commas. Please do not insert a period after the keyword sequence.
German Keywords
Insert the corresponding 5 to 10 German keywords here.


Insert the main body of your manuscript here. 
Note: Organize your manuscript by headings into an unambiguous hierarchy with no more than four levels and at least two headings at each level. Please use the heading templates below (JBDGM-H1 to JBDGM-H4) to indicate the corresponding heading level. Please do not set custom styles. Please also note that according to APA7 guidelines, headings are not numbered.
Please start the main body of your manuscript with the first heading.
Heading 1 (MS Word Paragraph style: JBDGM-H1)
For the main body of your manuscript, please use the paragraph style JBDGM-Text provided in this document. 
Direct quotations of more than 40 words should, according to APA guidelines, be inserted as an intended paragraph and not include any quotation marks, as shown here (paragraph style JBDGM-Quote).
For bulleted lists …
... please use the paragraph style JBDGM-List
Heading 2 (Paragraph style: JBDGM-H2)
Heading 3 (Paragraph style: JBDGM-H3)
Heading 4 (Paragraph style: JBDGM-H4)
Note: For further formal requirements regarding the main body of your text, please also pay close attention to the “Notes on Manuscript Formatting” at the end of this document.
References
Insert references here.
Note: Use APA style (7th edition) to format your references. Please also consider the supplementary “Notes on Manuscript Formatting” as well as the examples provided at the end of this document, which will point to some crucial exceptions from APA guidelines.
Appendix (optional)
Insert appendix here (optional).

Notes on Manuscript Formatting
The following instructions provide guidance on how to correctly format your manuscript. Please pay close attention to these guidelines in order to avoid any preventable and unnecessary delays during the publication process. Please make use of the paragraph styles provided in this document to format the main body, bulleted lists and headings.
Please ensure you remove all instruction pages from your manuscript before submitting it to JBDGM!
In general, JBDGM follows the guidelines of the APA publication manual (7th edition), with the exception of a few amendments clarified in the following. Useful additional information can also be found in the APA style blog (http://blog.apastyle.org/) and in the PsychOpen Author Guidelines (http://www.psychopen.eu/author_guidelines/). 
Gender-equitable Use of Language
JBDGM does not give precise instructions on how to use gender-neutral language in your manuscript. However, the use of “they” as a third person singular pronoun is generally encouraged. 
Enumerations and Lists
Enumerations within a text should be formatted in the following way: (a) …, (b)…. To format bulleted lists, please use the MS Word template JBDGM-List provided in this document.
Footnotes/Endnotes
JBDGM does not use footnotes, but exclusively endnotes. Please use endnotes sparingly. Use the in-built MS Word function to insert endnotes, with lower case Roman numbers (i.e., i, ii, iii, iv etc.).
Tables
Only use the MS Word table editor (“Insert” > “Table”) to create tables. Please use the gridlines (“Table” > “Layout” > “View Gridlines”) in Word so that all the dividing lines of the table cells are visible. This is the best way to review the structure of the table.
Insert the tables in-text in their normal position and not at the end of the document (unless they are considered appendices). Each table should have a consecutively numbered table heading in bold print, with a font size of 10 pt, non-italic (paragraph style JBDGM T/A-Heading): “Table n”, as well as a table name, placed directly below the corresponding heading with a font size of 10 pt and in italics (paragraph style JBDGM T/A-Name). Table annotations are required to be positioned below the table with a font size of at least 9 pt (paragraph style JBDGM T/A-Annotation).
Please note: The tables in this document are only used to transmit the correct table structure and content. Therefore, the layout does not yet follow the APA 7 requirements at this point. In the course of the publication, the appearance will be automatically adapted to APA later on to match the respective publication medium and format.
Important:
Never create tables using tab stops, spaces or line breaks, not even within a single table cell!
Each row/column in your table must be clearly defined. Please do not write several values next to each other or one below the other in a table cell but split them up into several unique columns or rows.
Please do not use any shading or colouring.
The font size used in tables can be as small as 8 pt. (Arial).
Each table must be referred to before its appearance in the text, e.g., “(see Table 1)” or “as shown in Table 2”.
Example of incorrect (Table 1) and of correct (Table 2) table formatting:
Table 1 [This is the table heading]
Example of INCORRECT table formatting [This is the table name] 
	        Group 1
	           Group 2
	

	   M     SD
	   M	SD
	p

	   3.2     1.2
   4.1     0.8
	   2.7	2.1
   3.2	.11
	  .23
< .001


Table 2
This is a correctly formatted table with unique rows and columns
	Group 1
	Group 2
	p

	M
	SD
	M
	SD
	

	3,2
	1,2
	2,7
	2,1
	,23

	4,1
	0,8
	3,2
	0,11
	< ,001


Note. This correct table shows only one value in each cell.  [This is a table annotation.]


Figures
For the initial anonymized submission, please simply embed screen-optimized, low-resolution (< 100 dpi) versions of your figure into the desired position within the main body of your manuscript. Print-ready, high-resolution versions are only required for the final submission and if your article gets accepted.
Create your figures using a white background and no image borders. The figures should be prepared in greyscales whenever possible, with the goal of providing figures that are legible or recognizable when printed from the article on a monochrome printer. If colour images are used, please make sure they can be read and recognized when printed out on a monochrome printer. This also applies to photographs. Text within figures must be in Arial font (exception: symbols not available in Arial), and between 8 and 12 pt. As figure legends are an integral part of a figure, they must be placed within it. Major words in legends should be capitalized. By contrast, figure headings and, if applicable, footnotes should be included in the main body of the article, and not as part of the figure. Capitalize only the first word (exceptions: proper nouns and the first word after a colon or a dash).
Each figure should have a consecutively numbered figure heading in bold print (e.g., “Figure 1”), with a font size of 10 pt (paragraph style JBDGM T/A-Heading), a figure name, placed directly below the corresponding heading with a font size of 10pt and in italics (style JBDGM T/A-Name), and, if applicable, a figure annotation (style JBDGM T/A-Annotation).
Each figure must be referred to before its appearance in the text, e.g., “(see Figure 1)” or “as shown in Figure 2”.
Figure 1 [This is the figure heading]
German Logo of the Yearbook of Music Psychology [This is the figure name]
[image: C:\Users\anh67zb\Desktop\jbdgmPageHeaderLogo_de_DE.png]
Note. This is a figure annotation.
Statistical Measures
Please always report exact p-values and effect sizes (e.g., not only binary information on sig. vs n.s.).
Within the main body (not applicable for abstracts), statistical measures referred to as Latin characters are reported in italics (e.g., N, r), whereas Greek letters are referred to in non-italics (e.g., χ2, Ω).
According to APA style, please coherently report decimal places (sample size and degrees of freedom without decimals; highly significant p-value with 3 decimals; in most other cases, a maximum of 2 decimals is sufficient).
Please only indicate a 0 before the decimal point if the statistical measure can exceed a value of 1. Example: SD = 0.12, but α = .74.
In case of multiple parenthesis levels, e.g., in the form of (F[1,10] = 2.73, p = .27, η² = .01), please use round or squared brackets for the corresponding hierarchical level.
Diagrams, Formulas, Special Characters
Please insert diagrams as images into the text (instead of importing them from another software). Formulas can be created using the MS Word formula editor. In case of complex formulas, the insertion of an image (on a separate line) within your text is equally valid. However, please do not include special characters as miniature images. Instead, use designated Word fonts (e.g., Symbol) or the Word Symbol Function under “Insert > Symbol”.
Direct and Indirect Quotations
JBDGM follows the APA manuscript manual (7th edition).
The following table shows how to correctly cite in-text references:
	Total number of authors
	References in parentheses
	References in continuous text

	one author
	(Wagner, 2019)
	Wagner (2019)

	two authors
	(Wagner & Müller, 2019)
	Wagner and Müller (2019)

	three or more authors
	(Wagner et al., 2019)
	Wagner et al. (2019)



Unlike in the 6th edition of the APA guidelines, references with three or more authors are no longer differentiated as to their first and subsequent citation within a text.
Direct quotations of more than 40 words should be indented and not include any quotation marks. Please use the paragraph style JBDGM-Quote, available in this document. The author’s surname(s), year of publication as well as page number should be referred to directly afterwards, in brackets.
References
All references need to be in APA style (7th edition) and complete before the manuscript can proceed to copyediting. In case of incomplete formatting or considerable APA violations, we reserve the option of returning the manuscript to the authors for further revisions before the copyediting process is initialized. Please also ensure you include DOI numbers or permanent URLs as a hyperlink for all references, where available. Please note: In case of submissions in English, English abbreviations should be used consistently throughout the reference list (“Eds.”, “ed.”, “p.”, etc.), even if all other source details are specified in a different language. Please use the paragraph style JBDGM-Literature to format your reference list. 
Please take the following examples of common source types into account. For all other cases (e.g., reports, sources in languages other than German or English, unpublished manuscripts, etc.), please refer to the APA manuscript style manual, 7th edition.
Journal article:
Dellinger, A. B., & Leech, N. L. (2007). Toward a unified validation framework in mixed methods research. Journal of Mixed Methods Research, 1(4), 309–332. https://doi.org/10.1177/1558689807306147
Journal article with an article number:
Schäfer, T. (2016). The goals and effects of music listening and their relationship to the strength of music preference. PLOS ONE, 11(3), Article e015163. https://doi.org/10.1371/journal.pone.0151634
Journal article, Online First Publication:
Devenport, S. P., & North, A. C. (2019). Predicting musical taste: Relationships with personality aspects and political orientation. Psychology of Music. Advance online publication. https://doi.org/10.1177/0305735619864647
Book chapter:
Jackson, A. J., Miller, J. T., & Stevens, G. K. (2012). School anxiety: Teacher-rated stress factors in Bulgarian school children. In M. Brunner (Ed.), Psychology in schools (2nd ed., pp. 12–37). School Press.
Monograph:
Teddlie, C., & Tashakkori, A. (2009). Foundations of mixed methods research: Integrating quantitative and qualitative approaches in the social and behavioral sciences. Sage.
Website:
Yearbook of Music Psychology. (n. d.). Hinweise. https://jbdgm.psychopen.eu/index.php/JBDGM/Autorenhinweise 
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